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15.0 INTRODUCTION

Computers have the capability of two way communication, simultaneously
sending and receiving information to and from other computers. This allows
us to set up groups of interconnected computers sharing information. We
call them a network. And networks can be connected to each other allowing,
say your computer, with computers connected to these networks across the
globe. This massive network of computers is what is called the Internet. So
when you connect to the internet using one of the connections provided by
an Internet Service Provider, your computer is connected to their network,
which in turn is connected to other networks across the globe.

The World Wide Web (WWW) or the web in short, is a huge set of
interlinked documents, images and other resources, riding on this network.
All this digital information is typically stored on hard disks and other
storage devices on each of the computers on the Internet. They are linked to
each other through hyperlinks and URLs. So when you launch your browser,
say Internet Explorer or Mozilla Firefox, and type in http://www.ignou.ac.in ,
you are requesting to view those pages which are stored on a computer
accessed through this address. Each such address is known as a Uniform
Resource Locator (URL), a unique address for each page on the web. You can
access all those related pages clicking on links, jumping from one page to
another; these links are called hyperlinks. These hyperlinks and URLs allow
the web servers and other machines that store originals, and cached copies
of, these resources to deliver them as required to users seeking this
information. Each group of related web pages, and related resources (images,
databases, etc.) accessed from a URL constitutes a website.

For the purpose of this Unit, we shall assume that you have access to a
computer connected to the Internet. This is because many of the features,



94

Content Creation Tools applications and software, we will refer to, work on the web. Therefore, we
suggest, even if you do it occasionally, you should connect to the Internet
and try out these features. Further, your understanding of web technologies
would depend on your critically viewing, analysing, and deconstructing a
variety of websites.

15.1 LEARNING OUTCOMES

After working through this unit, you are expected to be able to:

• Plan for and design a website;
• Identify tools for creation of web-pages;
• Write basic HTML tags;
• Create web-pages using HTML editors;
• Integrate media and scripts into web-pages; and
• Use simple and free CMS tools to create a website.

Please note that we distinguish between a plan and design on paper and its
actual making using various tools and technologies. For this unit, we will
restrict ourselves to design on paper, although you will become aware of the
tools and technologies, and hopefully, inspired enough to start learning to
use them.

15.2 THE WORLD WIDE WEB: AN INTEGRATED

MEDIA

The web today can function as a container and disseminate a wide variety of
digital information – text, pictures, audio, and video, separately or combined
together. It would therefore be appropriate to refer to the web as an
integrated media.

As we mentioned earlier, a thematic collection of information weaved
together with a common design, and placed on a server (a computer on the
Internet which serves digital content in response to a request from a client,
say your computer) in the form of interlinked pages and programmes is
called a website. Also, a website has a unique URL, an address which
distinguishes it from other websites.

In order to view web pages, you use a software application like Internet
Explorer or Mozilla Firefox. Such software applications are called browsers,
because they facilitate browsing of the Internet. Browsers are designed to
communicate with servers on the Internet, send and receive data, interpret
and display them in a window. With the help of other software applications
called plugins (they are plugged into the browser to enhance its capability),
they can play audio or video files, show pictures or animations, or enable
filling up and submitting of forms.

In the subsequent sections, we will design our own website with some
distinct web pages. The purpose of the exercise would be to become aware of
the various purposes of web based dissemination, various possibilities that
the web offers and various tools and techniques available on the web to
facilitate these activities.
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15.2.1 Web Pages and Websites

The first step in this process is to decide what you want to say. Like any
other communication, a website must also have a purpose, a theme, about
which it wants to inform its visitors (or users or readers or viewers). Let us
say you are fascinated by trees and wish to tell the world all about it. You
will get yourself an appropriate URL like http://ourtrees.com (see section
15.4 below). Right now, you are only planning your website.

What would you like to inform your visitors about trees? Make a list of all
that you want to and categorise them. Perhaps you want to tell them about
individual trees. You may want to discuss different habitats and how it
influences trees. You may want to talk of the produce and their uses. You
may want to talk about cutting down of trees and its influence on the
environment.

Obviously each category of information is distinct and will have its own
separate section. Each section may even have many distinct pieces of
information and may have to be put on separate pages. Say, for instance, you
wish to talk of trees on mountains, trees of the plains, trees near water
bodies, trees on the sea coast or trees in a desert.

You do not have to complete this task, but it would be useful if you have
enough information in each of the sections and pages. Unlike a printed book,
a website need not be complete before its publication. You can even add
entire sections or delete them as and when you choose. In fact, most websites
perennially grow, becoming more and more complex and deep.

How does your website now look? You have a main page announcing the
theme and perhaps a list of the sections of the site – a kind of cover page and
contents page woven together. This page is generally referred to as the Home
Page (or the index page). You will realise why it is called so, shortly. Each
section will have its own page or pages. As the site grows, more and more
branches get added and each branch may break further into more sub-
branches. A map of all these pages is called a Sitemap. Sitemaps of very large
websites can be complicated indeed. Many websites have a link named
‘Sitemap’ on their homepage. Click on them and study the organisation of
content on that website.

Are there different ways of organising content? Does the nature of content
on your site have a bearing on the Sitemap? Organising information this way
helps you structure your website. Structuring it not only helps you decide
where each kind of information goes, but also helps the visitor move around
your site easily.

15.2.2 Navigation

How do you browse through a printed document, say a book? You may use
the contents page to locate a particular unit or sub-unit and then use page
numbers to locate that particular page. You may also use the index (if there is
one), select a particular keyword or concept and then use page numbers to
locate that particular page. The printed book has its organisation and
moving around is facilitated through the use of page numbers, index of
contents or a contents page. This of course is not always the case.  In some
cases, like in the case of a novel, there may neither be a contents page, nor an
index. The author expects you to start on page 1 and go through each page,
right up to the end. Even this book has an organisation, a linear one. In the
case of a properly indexed book, you can jump from one section to another at
will.
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Content Creation Tools The web facilitates this feature through a hyperlink. Clicking (with the left
button of your mouse) on a hyperlink takes you directly to a particular
section of the same webpage, or to another webpage or to a particular
section on the second webpage. You do not have to go to an index page to
look for the location of the keyword. While this greatly facilitates movement
around the web, it has its flip side too. Keeping track of what you clicked
and where you have landed is difficult. Many visitors get totally lost,
particularly on sites which are very deep (with many levels of pages) or with
too many hyperlinks. Facilitating the easy and rapid movement of the visitor
to desired information and come back to particular pages from where they
started is the purpose of designing a good navigation scheme.

Navigation is a feature of the organisation of your website. It helps visitors keep a
tab on where they are (on which webpage) and what is the relationship of
this page to the rest of the website. How is this achieved?

1) A simple structured sitemap: If the site has few levels of pages and
unambiguously organised into sections and sub-sections, the visitor
finds it easy to locate oneself on the website. A well structured site
allows you to come back to the first page, the home page.

2) Fewer hyperlinks: Each click on a hyperlink takes the visitor away from
the information being viewed. So, unless essential, avoid hyperlinks.
This of course would be challenging. When you have different levels of
visitors, you may find a need to explain each and every concept. If it is
only a short meaning, or example,  or a definition, a small pop-up
window (or a tool tip) can be used. This helps avoid navigating away
from the page.

3) Display an index of contents: On some sites, you notice a column of
headings and sub-headings always displayed. Each time you select a
particular section, that word or phrase may get highlighted (become
bold, change colour, etc.) and the relevant page displayed on the right of
this index column. This allows you to go up and down this list, selecting
the pages you desire. Different websites use different ways of achieving
this objective.

4) Display a ‘You are Here’ sign: On some sites, you notice a sign like
home>>types of trees>>deciduous>>silk cotton somewhere at the top of the
page. Silk cotton refers to the current page. Clicking on each preceding
word will take you back one level. If you click on home, you are back on
the home page or the index page of the site. These are called
breadcrumbs and display the path from the home page to the current
page, enabling easy navigation up this branch.

Check Your Progress 15.1

Notes: a) Write your answers in the space given below.

b) Compare your answers with those given at the end of this unit.

1) Distinguish between the Internet and the World Wide Web.

............................................................................................................

............................................................................................................

............................................................................................................

............................................................................................................

............................................................................................................

............................................................................................................
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............................................................................................................

............................................................................................................

............................................................................................................

............................................................................................................

............................................................................................................

15.2.3 Integrating Media

Websites can be colourful. People use graphics to enhance the design of the
site, to highlight the theme of the site, or as specific examples of the
information the page offers. Banners for advertising products and services
are also included on sites. While some of these are still pictures
(photographs, drawings, maps or graphs) some others are animations
(moving graphics). One could also incorporate audio or video into the page.

Should you use graphics and animation on your site? How many and how
often? What are the technological implications of media incorporated into
web pages?

As we discussed in Units 11, 12 and 13, graphics, animation, audio and video
are digital files. Depending on their image size and file size, these files can
be very large. You may like to revise relevant sections of those units at this
point. Typically a visitor to your website is connected to the Internet through
a dial-up or a broadband connection, which is not always fast. Let us say the
connection is clocking 50 Kbps (a file of size 50 kilo bytes will take one
second to download completely onto your computer). A file of size 1 MB
would take 20 seconds. How long would the graphic or audio or video take
to download and play on your browser? If there are many media elements
on your page, what would happen to the file size of this page? Can you
account for why some websites take long to open? Compression technologies
for media files or streaming servers for audio and video files, which you
learnt about in Units 11, 12 and 13 could help to some extent.

Figure 15.1: Advanced Menu of Internet Explorer
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display of graphics and animation. For instance in Internet Explorer go to
Tools->Internet Options, select the Advanced Tab, and under the section
titled Multimedia you will find an option called Show Pictures (See Figure
15.1). Click on the check box to remove the tick mark and click on the OK
button. Now reload the web page you were looking at. Does it load faster?
You will notice blank boxes where the graphics or photographs were. You
could similarly shut off animation, audio, and video.

Look at this situation from the point of view of a web designer. One, if you
want your visitor to access your pages fast, keep its file size small. That could
mean smaller file sizes for the media (you have learnt this in Units 11, 12 and
13), smaller number of media elements and a prayer that the visitor has not
shut off pictures on his/her browser. Two, distinguish between messages and
decoration. See Fugure 15.2, where (a) uses media elements because that is
what it wants to show, e.g. this is the structure of the human brain; and (b)
uses media elements, because they look nice.

Figure 15.2: Images on a website

Browsers are normally equipped to handle pictures and animations (the .GIF
kind). For everything else, like flash animation, audio files and video files,
browsers need installation of special software. They are installed as plugins
into the browser. For instance a Quick Time player plugin is required to play
quick time movies (filename.qt) or a Flash plugin to play flash or shockwave
files (filename.swf). For the designer / web developer this implies selecting an
appropriate technology for each kind of media. This also has implications for
server capabilities (see the section 15.4 in this Unit). So, you should provide a
message like “You will need Quick Time player to view the video on this
page”. You may also provide a link to the website from where the visitor can
download the player. Generally all media players can be downloaded free.

15.2.4 Static and Dynamic Websites

In order to understand the concept of static and dynamic pages and their
utility, let us consider a case study. The Indian Railways (http://irctc.co.in)
runs a website which allows passengers to manage their railway bookings.
This site allows you, from anywhere across the world, to select a train on a
particular date, and book your tickets. Even payments are made online and
tickets printed on your local printer. This site uses a very important feature
of web technology and significant to our understanding of communication
using the web.



99

Creating Materials for the

Web
Let us take a specific case of ticket booking to understand this better. Let us
say, a passenger logged in to this site from Tokyo, wishes to buy a ticket from
Kolkata to Delhi on a particular date. He/She only has information about the
locations and the date. He/She feeds in this data into a form and the website
responds back with the various possible trains, availability of seats in various
classes, along with the timings of the train. He/She makes his/her choice of
train, fills in his/her personal details and seeks a booking. The website seeks
a confirmation and passes him/her on to a payment gateway. He/She uses a
credit card to pay and when the payment is confirmed the website displays
his/her confirmed ticket, which he/she can print and use.

The process looks pretty straight forward. If you were a website designer
you could make different pages for each of the functions of this site – one for
selection of trains, one for showing availability, one for filling up personal
details, and so on.

Now consider these facts.  Indian Railways operates about 9,000 passenger
trains and transports 18 million passengers daily across twenty-eight states
and one union territory. A standard passenger train consists of
eighteen coaches, but some popular trains can have up to 24 coaches.
Coaches are designed to accommodate anywhere from 18 to 81 passengers,
but during the holiday seasons or when on busy routes, more passengers
may travel in a coach. (from http://en.wikipedia.org/wiki/Indian_Railways).

About 12,500 people are being booked each minute. And each of these
passengers is seeking a ticket for any one of the 9000 trains, for any of the
stations which the train goes through. And the website offers choices of
different classes of travel, choice of berths, and concessions for different
categories of people. Indian Railways allows you to book a ticket 60 days in
advance. So, on any day, you can book a ticket for a train on any one of those
60 different dates. Further, each day, the first day is removed from the list
and the 61st day added.

If each possibility were to be listed on a unique page, how many pages
would have to be made? It would be almost impossible to make different
web pages for each of these different possibilities. And a lot of information
keeps changing. Trains are cancelled or rescheduled, new trains introduced,
new stoppages introduced for trains, special trains added to cater to the
rush, etc.

Figure 15.3: The Indian Railways  reservation system website
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Content Creation Tools So, the website of Indian Railways reservation system serves thousands of
different web pages (each of them distinct) to thousands of people,
simultaneously. And there must be thousands of websites doing similar
transactions, for example, your bank’s website, http://wikipedia.org, http://
amazon.com, http://google.com. And at no time do we see such websites
groaning, when you request a page. How is this feat achieved?

A beautiful piece of technology comes to the rescue. This is called Structured
Query Language (SQL), a computer language for querying and modifying
data and managing databases. This kind of a website consists of web pages
with appropriate blank tables and a database at the back consisting of all the
information, neatly organised into tables. So, when you ask, “What are the
possible trains we can take to make a journey from, say, Kolkata to Delhi?”
you fill up a form and press a link labelled Find Trains. This form now
translates your request into an SQL query, something like, SELECT *FROM
trains WHERE from_city LIKE “Kolkata” .and. to_city LIKE “Delhi” echo
“Train No.” echo “Train Name” echo “Station From”  echo “Station To”...
Please note that this is not the exact code; it is only to indicate the complex
processes that happen in the background; the exact code depends on the
software platform and various other technical details.

This SQL statement is communicated to the database, which rapidly searches
the table named “Trains”, under the column “Station from” for an exact
match of the word “Kolkata”, filters the table such that only data which
satisfy the condition “Station from” = “Kolkata” are considered. Now it
searches again for an exact match under the column “Station to” = “Delhi”.
Let us say this throws up six possible trains. The database then sends the
results to a new webpage, having blank tables, which can display the trains
(“Train No.; Train Name; Station From; Station To; Availability of train on
different days of the week”)

This technology allows multiple requests of this kind to be submitted
simultaneously and results of the query (different results for the different
queries) sent back. As each of these web pages contains blank tables to begin
with and the results are dynamically generated and displayed, we call such
pages dynamic pages. And the web site therefore is a dynamic site.

As opposed to this, the site you were making http://ourtrees.com consists of
pages which are already made and stored on the server. When a visitor
requests a page (say, by clicking on a link), this pre-existing page is retrieved
and displayed. The information sought and obtained is therefore termed
static, the web page termed a static page and the web site a static site.

Look around for other examples of static and dynamic sites and study their
query capabilities. Among the popular technologies which are used to create
dynamic sites are Active Server Pages (ASP, ASPX), Java Server Pages (JSP),
PHP Hypertext Preprocessor (PHP). You can make out the technology used
by examining the URL, for example, when you make a query on http://
wikipedia.org (We put in ‘dynamic site’ as the search word and clicked the
button search), you will find the following URL http://en.wikipedia.org/w/
index.php?title=Special:Search&search=dynamic+site&fulltext=Search; the
technology used in this case is php. A similar search on http://msn.com (We
put in ‘dynamic site’ as the search word) yielded the query http://
search.msn.com/results.aspx?q=dynamic+site&FORM=MSNH11, which
shows that the technology used in this case is aspx.
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Notes: a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

Discuss the advantages of a dynamic website over a static one.

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................

15.3 BEHIND THE WEB PAGES

It would be interesting to know what happens behind these web pages,
which facilitates such a variety of information, rich in colours, structure,
images, functionality, to be sought and displayed at the click of a button.
What is requested from the server when you type in a URL into a browser or
click on a hyperlink? What data travels and how is it interpreted?

Connect to the Internet, launch your browser and type in a URL of your
choice. A web page corresponding to the URL you typed is displayed in your
browser window. Study the page carefully. What information do you find on
it? Much of the information is likely to be text. You may also find some
pictures. It is also likely that you will find a form, wherein you will have to
input words – like a search word or a username and password.

Now go to the View menu and select Source or right-click anywhere on the
page and select Source from the pop-up menu (In Mozilla or Chrome
browser, it is listed as page source). What do you see? Though at this
moment it may not make any sense, this is the actual text which travels from
the server to your browser, each time you seek a page. The browser reads
this code and translates it into the pretty web page that you see.

Figure 15.4: The source code of a web page
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First things first. The language a browser has been programmed to read is
called the Hyper Text Markup Language (HTML), which as on date (in 2009)
is in its fifth version (HTML5). And the codes it uses are called tags. Tags
have attributes, for instance you might want your text to use Times Roman
font, with a type size of 20. Tags usually come in pairs – a beginning tag and
a closing tag, for example <p>OUR TREES </p>. When a browser reads this
pair of tags, it will display the text in between the tags as a separate
paragraph. If you see a tag beginning with <! and ending with>, the browser
will interpret it as a comment and will not display it on the web page. This is
useful for a web programmer to put in notes and comments about the tags
used.

For rest of this section, we will familiarise you with some of these codes and
discuss its power and utility. For this we would be using an editor named
NVU from http://net2.com/nvu/download.html. NVU (pronounced as “N-
view”) is a free, open source software program that allows you to build
websites and web pages using a simple editor. We refer to editors like NVU
as WYSIWYG (What You See Is What You Get), because they allow you to
preview your webpages, within the editor, allowing you to fix your errors as
you work.

WYSIWYG editors also help in another way. While it may be possible for us
to remember many tags and even attributes, all computer codes have to be
exact. Even a misplaced comma (,) or semi colon (;) can yield disastrous
results. Programmers spend enormous chunks of time and professional skills
locating and rectifying such faults. Using HTML editors allows us to
concentrate on the functionality leaving the program to write up its own
code. But as you progress to become a more advanced web developer, you
will revisit the source code and tweak it.

Let us explore the use of NVU. Download the file nvu-1.0-win32-full.zip and
extract it (We assume that you are using a Windows operating system on
your computer. If you are using a Mac or a Linux machine, you may
download the appropriate file for your system). You should find all the files
in a folder called nvu-1.0PR. Open this folder and double-click on nvu.exe.
And you are ready to make your web page.

Figure 15.5: Interface of NVU
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The pane on the right is where you develop your page (see Figure 15.5).
Observe the tabs at the bottom of this pane. These are different views of the
HTML page you are constructing. The Normal tab shows the page as it would
look in a word processor. The ‘HTML’ tab shows the page with markers
indicating the HTML tags used. The ‘Source’ tab shows the HTML tags and
their attributes. The ‘Preview’ tab shows the page, as it would appear in a
browser – your actual web page.

Select the source tab. What do you see? These tags are the basic tags, all web
pages have. You will insert the rest of the tags. Put in a title for your page,
between the <title> </title> tags. Click on the Normal tab. You will still see a
blank page. Notice that the title is visible right on top, on the window frame.
This is not the heading of your page.

Now type in your text, just as you would in a word processor. Put in a
heading. Using the toolbar on the top, you can highlight the text in different
ways – change the colour, change the font and size of the text use bold, italic
or underline. You may format the text – left or right align portions of the text,
insert paragraph breaks. You may also insert an image - position your cursor
on the page, select the image button from the top tool bar (or select Image
from the Insert menu). Looking at the text, can you identify the highlighting
or formatting you have made to the text?

Figure 15.6: Source View in NVU

Let’s continue the Ourtree.com example that we started. Suppose you have
typed some content as in Figure 15.6. Now switch to the source view (click
on the source tab). What do you observe? In the box below, we present a
typical text with all its highlighting and formatting. We then discuss its
HTML code.
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<!DOCTYPE html PUBLIC “-//W3C//DTD HTML 4.01 Transitional//EN”>

<html>

<head>

<meta content=”text/html; charset=ISO-8859-1" http-equiv=”content-type”>

<title>Our Trees</title>

</head>

<body>

<div style=”text-align: center;”>

<big style=”color: rgb(255, 0, 0);”>Trees Around Us</big><br>

</div>

<br>

Trees are among the most majestic of living things. They are found everywhere around

us. Perhaps the deep oceans are the only place on earth, where you will not find trees.

<br>

<div style=”text-align: center;”><img style=”width: 146px; height: 100px;” alt=”Amaltas”

 src=”http://ourtrees.com/floweringtrees/amaltas.jpg”><br>

</div>

<br>

Many trees bear flowers, which turn into fruits. When in full bloom, many of these

flowering trees are a spectacular sight. <br>

The <span style=”font-weight: bold;”>Indian Laburnum</span>

or <span style=”font-style: italic;”>Cassia Fistula</span> is without doubt one of our

loveliest flowering trees. To know more about this tree

<a href=”http://ourtrees.com/floweringtrees/amaltas.htm”>click here</a>. <br>

</body>

</html>

So, you have created your web page. Save it as webpage.htm in a folder of
your choice. Open it in a browser to check your work. If you were only
trying to create a web page, then this is all that you have to do. But a website
is a little more elaborate. Remember a website is a collection of pages linked
to each other. The web pages may share some resources, for instance you
may have a logo or menu bar, which occurs on all the pages; you may also
like to organise all the documents and images in their respective folders.

Plan out your site – draw up a sitemap, which shows what pages will exist
and what will be the linkages between them. You could use a word processor
or even the concept mapping tool, Free Mind, that you studied in Unit 11.
Create a folder which will hold all your web pages and resources. Create
appropriate subfolders, for documents and images. Collect the images and
other resources you will need in the appropriate folders. Now you are ready
to develop your site. NVU provides a very comprehensive help document to
give you step by step instructions for anything you wish to achieve. Click on
Help -> Help Contents to access the help document. (See Figure 15.7).

Repeating the process you used to create a webpage, create each of your
individual pages as per your site map and save them in your web folder. Test
them in your browser, checking for hyperlinks, formatting, display of
images, etc. Publish the pages in NVU. What remains is uploading your
pages on to the web server.
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Figure 15.7: Help Menu in NVU

Let us look at the HTML tags which helped us create this page. There are
tens of other tags with very elaborate sets of attributes. But, it will not be
possible for us to cover all of them here. But we will refer to some web
resources (tutorials, notes and help) on HTML, which you may like to use.

Tags used for formatting text

• <br> used for creating a line break; alternately one could use a <p> </p>
for a new paragraph. You will also notice that a closing tag </br> has not
been produced by our HTML editor NVU. In the latest version of HTML
a closing tag is preferred, although most browsers can interpret it
without the closing tag.

• <div style=”text-align: center;”> </div> used to define a block of content,
particularly useful to restrict text and/or images to specific locations on
the page. Notice the attribute used in this tag. “text-align: center;” used
for centering text on the page; one could also use left, right, justified to
position the text.

• <span style=”font-weight: bold;”>, <span style=”font-style: italic;”> or
<span style=”color: rgb(255, 0, 0);”> and the closing tag </span> used to
highlight text; the attribute style= defining what should be done with
the text.

Tags used for inserting images

As the images are independent files – one could use images of different
formats, usually jpg, gif, png – an indication of where that file resides with
reference to the web page file has to be indicated. The size of the image on
the web page is also specified. It is also common practice to provide an
alternate text, in case the show pictures option has been shut off. This use of
alternate text also serves a more important function. Persons with visual
disabilities, who use screen reading software will now be able to obtain a
clue to this image. Combined with other tags, images can be positioned and
restricted to different locations on the web page. Instead of images, one
could also insert a video or an audio file, which of course will require
reference to specific players too.
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<img style=”width: 146px; height: 100px;” alt=”Amaltas” src=”http://
ourtrees.com/floweringtrees/amaltas.jpg”>
</div>

In this example, <img> tag defines the image, the style= attribute defines its
size, the alt= attribute provides the alternate text and the src= attribute
defines the location of the image.

Tags used for hyperlinks

Hyperlinks to content are one of the most significant features of a webpage.
The tag should define the page or specific content on a page as the
destination of the link. In our example,

<a href=”http://ourtrees.com/floweringtrees/amaltas.htm”>click here</a>

the page amaltas.htm is called when you click on the link click here. It is a
good practice to use the complete URL (also known as the absolute URL).

Check Your Progress 15.3

Notes: a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

Using appropriate examples, describe the functions of tags, attributes and

values.

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................

15.3.2 Basic Design Considerations and Accessibility Issues

How good is your website or web pages? How do we approach this
question? Does a site which attracts a large number of visitors a good site?
When examination results are announced, millions of students visit these
sites. Does it therefore become a good site? Some web pages are beautiful to
look at, like an attractively designed brochure. Does it therefore become a
good site? Entire dictionaries or encyclopaedias are hosted on some site, and
you can find references to almost any word or concept here. Does it therefore
become a good site? You can buy almost any book that you wish at the click
of a mouse from sites like http://amazon.com. Does it therefore make this site
a good one?

Websites and web pages have a purpose. They may intend to communicate
information to a specific category of users, say medical professionals (http://
drugs.com) or to a broad category of users, like an encyclopaedia (http://
britannica.com). The use of colours, images, links, organization of content,
sections of the website would depend on who we are communicating to and
why. Defining the purpose and identification of the target group becomes
essential.  A website aimed at primary school children would be organized
differently from a site for adults. A website for cinema would not be
organized the same way as an online course.
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In any category we are bound to encounter a variety of users. Their
experience of using the web, their preferences, likes and dislikes, sensory
limitations, familiarity with the subject at that level, language abilities, and
current concentration and anxiety levels, would all have a bearing on what
the user receives. A good website is one which can simultaneously provide a
uniform experience to all the users. A tall expectation indeed! But with
experience and application, you will be in a position to come close to this
ideal. There are a number of very good resources on the web, which
provides you with information and research on the subject.

General rules applicable to the print media would apply here too. The
layout, use of graphics, colour, type size, spacing, etc. would enhance
readability and communication. The ease with which a user accesses
information would make the experience enriching. Appropriate
highlighting, organising chunks of information, supporting graphics,
appropriate use of hyperlinks can help.

Most websites are accessed through search engines. That is the user requires
information on some subjects, goes to sites like http://google.com puts in a
keyword or phrase and selects the first or the first few links from the search
results. Let us presume your website was the first listed. The user’s browser
displays this site, the user scans for the word or a phrase searched for, and
stays or leaves. This decision may take a few seconds to a minute. The
relevance of the information on your website, and how it enables a user to go
straight to what he or she is looking for will decide how long the user stays
and whether he or she will visit again.

The World Wide Web has universal access to the world’s knowledge as its
primary objective. And there are a large number of people who are in some
ways restricted from accessing the web. Most of the web uses the roman
script and communicates in English. Most of the people out there cannot
read or comprehend English. Today, computer technology has enabled
textual and audio-visual communication in almost every language of the
world. Fonts are available and browsers capable of interpreting them
(sometimes with plugins or installation of additional software). So if you
have a target group which cannot undertand English, then obviously your
website has to be in the language they can use.

Also your users could be visually impaired (to differing degrees) or
physically disabled. The spirit of the web has prompted software developers
to continuously endeavour to make the web equally accessible to such
people too. Screen readers, text enhancers (changing the colour, size and
spacing of letters), enabling printing or copying even on to Braille, use of
alternate text for images (alt text) can make websites accessible. The World
Wide Web consortium (http://w3c.org) has developed very detailed
guidelines for making web content accessible to different categories of users.

15.3.3 Ready-to-use Web-containers

The web has been around for over two decades and has encouraged and
generated enormous creative work in computer applications. Beginning as a
simple page where one could put in some text and images for others to see,
the web page has now become a multipurpose two way interactive medium,
handling a large variety of very complex data and computations. A variety of
technologies have also been developed to handle different media.
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with friends, and even have video conferencing using websites.

Simultaneously, this enthusiastic response to web technologies has generated
a Free and Open Source Software (FOSS) movement. Millions of software
enthusiasts use each other’s ideas and collaboratively develop thousands of
applications, which are then given away freely to users. Software which can
facilitate developing complex websites (like NVU), databases (MySQL) and
web servers (Apache) which can support dynamic sites, Chat forums – one
to one and many to many, News Groups, Blogs, have all been developed and
made available to the web community.

What this means is that if you want to start a blog, or a discussion forum, or
an online media library, you do not have to start with HTML code. Ready
made web ready applications, which can be customised (modified as per
your requirements) can be used to set up and host websites with very
advanced features and free. Incidentally the word free here is used by the
FOSS community in two ways. One, that it is being given to you without
charging you for the product; and two, that the right to modify it is also
yours.

One interesting application, particularly relevant to educational uses, is
Content Management Systems (CMS). CMS consists of a host of related
applications, which provide a ready made framework into which you can
put in your content and host it as a web site. The process of updating pages
and managing them are organised in such a way, that any ordinary computer
user should be able to manage it. CMS also incorporate advanced interactive
features like forums, blogs and wiki.

Many different CMS are available, and a large number of them are in the
FOSS category. A few examples of CMS in the FOSS domain are:

• Word Press http://wordpress.org
• Joomla http://joomla.org
• Mambo http://mambo-foundation.org
• Drupal http://drupal.org
• Plone http://plone.org
• PHPNuke http://phpnuke.org
• PostNuke http://postnuke.com

As these are free – you will also find free hosts (we will deal with web
hosting in section 15.4), we suggest you explore these CMS, define your web
site and run them.

Check Your Progress 15.4

Notes: a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this unit.

What are the advantages of a Content Management System?

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................
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REGISTRATION

We usually refer to a URL, a unique address for each web page; for example,
http://ourtrees.com/floweringtrees/gulmohur.htm. Let us analyse this
address. The phrase http:// stands for hypertext transfer protocol, a set of rules
which govern the transfer of text (or other digital content like images, audio
or video) between the server and client computers. The second part
“ourtrees.com” is known as the domain name and is the actual address of the
website. What follows the domain name, in this example, flowering trees/
gulmohur.htm refers to a file “gulmohur.htm” within a folder /
floweringtrees.

The domain name itself has two parts separated by a dot (.), for example,
http://about.com. In this, the latter part, i.e., com is referred to as the top-level
domain name or the first level domain name. The former part, i.e., about, is
referred to as the second level domain. If there are more than one part to
this, as in http://parliamentofindia.nic.in, then parliamentofindia is the third
level and so on.

Who assigns domain names? That in fact is another beautiful feature of the
web. Nobody controls it (We discussed this in Unit 2 in this Course). You can
obtain any domain name you want. In order to ensure unique assignment of
names and evolve policy guidelines for the management of the Internet, a
not-for-profit, public-benefit corporation called the Internet Corporation for
Assigned Names and Numbers, ICANN was formed in 1998. It has
participants from all over the world dedicated to keeping the Internet secure,
stable and interoperable.

Given this background to naming of domains, you are ready to obtain a
domain name. Various agencies have been identified as registrars of domain
names.  A search for domain name registration or domain name registrar or
web hosting will throw up lists of thousands of companies offering web
hosting and domain name registration services. If the name you choose has
not already been taken, you can apply for it and for a small fee, you will
become the owner of a domain name.

When you wish to set up your website, you contact a web host – a company
which manages servers connected to the Internet. For a fee (there are some
free hosts too), you are allowed to park your website (all the linked web
pages, databases, scripts, etc.) and domain name on one of their hard disks.
Once you do this, your website is up and visible to the world. Open your
browser, type in http://yourtrees.com and you are looking at the home page
of your website, just like any of the millions of users of the Internet would.

Some web hosts also offer packages where software applications like blogs,
wikis and content management systems are pre-installed. If you wish to use
one of these applications, say for instance, Joomla for your website, you will
find all the relevant resources configured and ready to receive your web
content.

How do you decide on the server you should select? First, the hosting plan -
how much hard disk space, how much bandwidth, service support and how
much does it cost. Second, the web design you have opted for – whether it is
a static or dynamic sites, if it is dynamic, then the database and server page



110

Content Creation Tools technology (asp, jsp or php), the other plugins and server side technologies
you need (for example a media server, if you want to host audio or video
with streaming capabilities).

While we do not expect you launch a dynamic website with a number of
complex scripts and software, it is useful to be aware of the complexities.
Search for web hosting on the web and look up a few companies offering
web hosting plans. Study their plans, costing, technologies and support. Also
look for readymade applications like wiki, blog, and CMS. Try out your
website on some of the free hosting plans. Update it, modify it, add and
delete pages. You can even start your own interactive forum for your
students.

15.5 EVALUATION OF EDUCATIONAL WEBSITES

In sub-section 15.3.2, we discussed a number of design considerations for
making a good website. A well made, universally accessible, well decorated
and functional website is a pleasurable experience to the visitor. But more
importantly, the visitor has come to your site seeking some information and
resources. Factors related to the content and its presentation also have an
important role to play.

What are the factors which need to be considered to evaluate a website?
Some of these are as follows:

1) Relevance of the content: The fine organisation of content and ensuring
up to date content is very essential.

2) Validity of the content: The authenticity and trustworthiness of content
increases visitors.

3) Dynamic content: Sites could host sets of Frequently Asked Questions
(FAQ) or forums seeking to redress student queries. Timely and valid
responses improve visitor satisfaction.

4) Presentation of Content: Language, typography – font, text-size, colour,
positioning of text, the balance between images and text, have an effect
on the visitor’s desire to stand and stare. Of course there is a fine
balance between just doing it right and over doing it. While what
colours and presentation style you use is strictly a personal choice, you
would do well to know what your visitors desire.

5) Hyperlinks and Navigation: Hyperlinks can be the gateway to a rich
deep website. It can also be an abyss in to which a visitor falls. Where
do you use a link, what is its purpose, what happens when the user
clicks on a link, how do you guide the user back, etc. will play an
important role in defining and effectively using hyperlinks.

6) User Friendliness: A straightforward presentation with simple, intuitive
navigation can make the site user friendly and help the user move
around and access content on the website easily.

7) Images: Graphics, pictures, moving graphics, video are all possible on a
web site. Use them with purpose, use them with discretion, and use
them to communicate.

While the above list is useful to evaluate any website, an educational website
would have additional factors associated with the pedagogical slant
preferred by you. If you prefer, say, an interactive forum where students
discuss and debate issues under your guidance (a moderated discussion), if
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you prefer, students submit assignments online and your feedback is
available publicly, if you wish to provide a one-to-one tutorial support to
students, then you are designing web pages which have a definite purpose
and functionality. Automatically, they are then to be evaluated for how
effectively they deliver on this promise.

There are a number of technological aspects of web design and
programming, which has a bearing on how web sites are developed and
deployed. But as these are beyond the control of a non-technical person, we
have concentrated on design aspects, which an educator can modify.

Develop a check list of your web site’s features. You may then use this to
obtain feedback from the visitors or a select group of users. Constantly
review your site and update its design to meet your visitor’s requirements
and effectively communicate your content.

Check Your Progress 15.5

Notes: a) Write your answer in the space given below.

b) Compare your answer with the one given at the end of this Unit.

How do you evaluate websites?

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................

.....................................................................................................................

15.6 LET US SUM UP

In this unit we studied how to create website. We list a summary of the unit,
below:

• The World Wide Web has evolved into a dynamic, collaborative medium
with a wide range of applications, which have enormous potential for
education.

• A website is a thematic collection of information and content weaved
together with a common design, and placed on a server in the form of
hyperlinked pages and software programmes. Each website is accessed
through a unique address called its URL.

• A hyperlink is one of the most significant features of the web. It allows
one to navigate from one page to another page, or a particular section of
another page.

• A good navigation design helps the visitor to the website to keep tab on
where they are (on which web page) and what is the relationship of this
page to the rest of the website.

• Websites can contain not only text, but also images, audio and video,
apart from special software which enhance the capability of web pages.
Browsers may require additional plugin software to display images or
play back audio and video files.

• Rich graphics can enhance the visual appeal of a site, but it also
increases file size, making its access slow.
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simultaneously to a large number of clients, use dynamic pages
supported by databases. The web pages communicate with the database
using SQL, serving responses to the queries of clients.

• Web pages use the Hypertext Markup Language (HTML) to
communicate information from the server to the client. Scripts and other
software programmes are used to enhance the range of functionality of
web pages.

• HTML consists of tags, which are the basic codes required for
formatting and displaying content. Each tag can have additional
attributes, which extend its functionality.

• WYSIWYG (what you see is what you get) HTML editors help you
develop web pages and organise them into websites.

• Universal Access to the world’s knowledge is the primary objective of
the World Wide Web. Guidelines of design and deployment have been
developed to ensure that all people, including those with disabilities, for
example the blind, can also access the content on the web.

• While a web page and a website can be manually created by writing the
HTML code and organising content, a number of ready made web
containers are also available. Content Management Systems can
facilitate the design and rapid development of websites. Some CMS can
have advanced facilities like chats, blogs or wikis.

• A domain name is a unique name assigned to a website. It is of the form
mywebsite.com, where com is the top level domain and mywebsite is the
second level. Different top level domains indicate different types of
websites. The assignment of domain names is governed by the
International Corporation for Assigned Names and Numbers, ICANN.

• A URL is of the form http://mywebsite.com/myfolder/mypage.htm and
provides the entire path and file name of each webpage.

• Placing a website on the World Wide Web involves parking a domain
name, and connecting it with the index or home page of the website.
The entire site consisting of the web pages and related content (images,
scripts) and any specialised software and/or database is hosted (placed)
on a server which is connected to the internet and hence is accessible to
the public all the time.

• Criteria for the evaluation of Educational websites can be evolved based
on the content, design, functionality and usage of different features of
the website. Its relevance, validity, authenticity, constant updating,
presentation, navigation and user friendliness can be used for rating a
website.

15.7 KEYWORDS

Content Management System: is the collection of procedures used to manage work
flow in a collaborative environment to manage files, folders, and processes in a web
environment. Typical CMS includes: Joomla, Drupal, etc.

Domain name: is a system identification to control the use of Internet address.

Hyperlink: is a link on a webpage that automatically transfer the user to another
page.

URL: is short for Universal Resource Locator, and signifies the web address of a
website.

Webpage: is a page of information on the World Wide Web that uses Hypertext
Markup Language or its variant to be accessible on the web.

Website: is a collection of webpage forming a distinct entity on the Web.
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15.9 FEEDBACK TO CHECK YOUR PROGRESS

QUESTIONS

Check Your Progress 15.1

1) The Internet is a world wide network of computers connected to each other
through a variety of wired and wireless communication channels. The World
Wide Web, on the other hand represents the set of all webpages, linked to each
other through hyperlinks.

2) Every website should have a well defined purpose, which helps select content; a
well defined organisation and navigation scheme, helping an user navigate
through the content easily and access the desired resources and information; a
good balance between aesthetic, cosmetic, functional elements, which would
result in an user staying longer at the site, without distractions.

Check Your Progress 15.2

A dynamic website responds to the queries of a user, generating webpages
dynamically. Such websites are serviced by a database and a query system. From a
developer’s perspective, it reduces the need to develop, maintain and modify a large
number of individual pages, makes updation very easy, and ensures fewer errors and
bugs. From a user perspective, it responds to a variety of information, serving
thousands of pages in response to thousands of separate queries. Use an appropriate
example to substantiate each of these points.

Check Your Progress 15.3

Tags are the unit of HTML code. Each tag, which occur in pairs define a function for
the browser. Tags could be for structure, formatting, navigating, or managing
external resources like media. Tags have attributes to extend their functionality, for
example, for defining colour or font and values help control the exact nature of the
attribute, for example, font=”arial”

Check Your Progress 15.4

A Content Management System (CMS) is a readymade web container with a number
of pre-defined functionalities. It generally has an administrative console, from which
one could manage various functions of the website, upload or download content,
assign roles and functions to users, and control the look and feel of the website. As all
these functions are pre-built, the developer can after initial customisation,
concentrate on populating and managing the content and not worry about the
programming. While this relieves an advanced user from day-to-day chores of
website management, it also allows a novice user to run an advanced website.

Check Your Progress 15.5

Websites have an organisation which caters to the purpose on one hand and the
requirements of the user on the other. All the different features of the website will
have to serve this purpose, enhancing its ability to attract and service the needs of the
user. Develop a checklist which can isolate each of the features of a website and
measure it. The measures could be quantitative or qualitative or both. If it is an
educational website, have a separate section on the content, its organisation and the
extent to which it meets the users’ needs.
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